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Introduction

License Agreement

HIGHWAY CAPACITY SOFTWARE™ (HCS™)
END-USER LICENSE AGREEMENT (EULA)

Effective Date: 10/15/2024

Copyright © 2024 University of Florida. All rights reserved.

This End User License Agreement (“Agreement”) is a legal agreement between you (“End User”, “you”) and the
University of Florida Board of Trustees for the benefit of the McTrans Center (“McTrans”, "we”) regarding the use
of the Highway Capacity Software (“Software”). By accessing or using the Software programs within the
electronically transmitted package or direct download, you agree to be bound by the terms and conditions of this

Agreement.

1. INTEGRATION:

This License Agreement is the complete and exclusive statement of the agreement between End User and McTrans
and supersedes any previous End User License Agreements distributed by older versions of the software proposal
or prior agreement, oral or written, and any other communications between End User and McTrans relating to the
subject matter of this License Agreement. This EULA will supersede the End User License Agreement contained in
the HCS Version 5, 6, and 7 modules disseminated as part of the Software. This License Agreement may only be
modified by a written agreement made subsequent to the date hereof and signed by both parties.

2. LICENSE GRANT:

2.1 Subscription-Based License:

McTrans grants you a non-exclusive, non-transferable license to access and use the Software, subject to the terms
of your active subscription. The license is valid only for the duration of your subscription and is contingent upon full
payment of all applicable fees.

2.2 Access to Software Versions:

Your subscription grants access to versions 5 (selected modules), 6 (selected modules), 7 and 8 series and beyond
(2022 onward) of the Software. When a new version of the Software is released, the End User with an active
subscription can download and access the latest version at no additional cost for the remainder of their subscription
term.

3. TYPES OF SUBSCRIPTIONS:
The type of subscription determines the permitted use of the Software. Once a subscription type is selected, it
cannot be changed or exchanged for a different type.
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3.1 Office-Based Subscription:

This subscription grants access to the Software for a predetermined number of computers within a physical office.
An "office" refers exclusively to a fixed geographical location, typically a single physical address, where an
organization conducts its business or operational activities. This location must consist of one or more contiguous
rooms or spaces within a single building. Virtual offices or any non-physical locations are excluded from this
definition.

The Software may be installed on multiple devices within the office, and access is restricted to end users officially
assigned to that licensed office. End Users may also use the Software on portable computers, such as laptops,
while on official travel, provided that all (100%) such use is exclusively on behalf of the office for which this Software
license was purchased. Additional offices must obtain proper licensing prior to accessing the Software. The
Software may only be installed on devices owned or controlled by the licensed office.

This subscription is intended exclusively for commercial use.

Virtualization Restriction:

The Software under an office-based subscription is prohibited from being used in a virtualized environment. All
installations of the Software must be conducted on a physical computer, such as a desktop or laptop. Remote
access technologies, such as remote desktop, are strictly prohibited under this subscription type.

3.2 Computer-Based Subscription:

This subscription permits the installation and use of the Software on a specified number of individual devices. An
"individual device" refers to a single, standalone computing unit, such as a desktop or laptop, intended for use by a
single user at a time. It is not shared concurrently with other users and is intended for use by a single user only The
Software may only be accessed directly from the device(s) on which it is installed, regardless of whether the device
is located in a physical office or used in a virtual office. End users working remotely or in virtual offices must ensure
that the device remains dedicated to their use and fully complies with the terms of this subscription.

Virtualization Restriction:

The Software under a computer-based subscription is prohibited from being used in a virtualized environment. All
installations must be conducted on a physical computer, such as a desktop, PC, or laptop. Remote access to the
Software via any technology, including but not limited to remote desktop, is strictly prohibited under this subscription
type.

3.3 Academic Subscription:

The academic subscription is available exclusively to academic institutions and grants access to a specified number
of seats (copies) across the entire academic institution. This subscription is intended solely for use in a classroom
setting for teaching or a lab for research purposes under the direct supervision of faculty or other authorized
personnel. The Software may only be installed on devices owned or controlled by the academic institution.

The End User is required to implement appropriate protection measures to prevent students or any other individuals
from copying the Software and removing it from the lab or classroom environment. The responsibility for
safeguarding the Software and preventing unauthorized copying or distribution rests entirely with the End User.

Virtualization for Virtual Classrooms:

Under the academic license, the End User may request permission to utilize a virtual environment for the installation
and use of the Software. Such virtualization is only permitted with prior written consent from McTrans. If such
permission is granted, the virtual environment must adhere to all protections and restrictions outlined in this
Agreement, ensuring that the Software is used exclusively for its intended educational purposes and its access is
limited to the institution's faculty and actively enrolled students only. Additionally, the number of seats purchased
must be sufficient to cover the number of students and faculty accessing the virtual classroom.
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4. SUBSCRIPTION TERM:

4.1 Duration:

The subscription term begins on the date of purchase and continues for the period specified at the time of purchase
("Subscription Term"). The license granted under this Agreement is valid only for the duration of the Subscription
Term.

4.2 Renewal:

Subscriptions may be renewed upon payment of applicable fees before the end of the Subscription Term. If the
subscription is not renewed, access to the Software and all related services, including technical support, will be
terminated.

5. TECHNICAL SUPPORT:

5.1 Support Services:

During the active Subscription Term, the End User is entitled to reasonable telephone or email support provided
during the normal business hours of McTrans. McTrans reserves the right to determine the extent of the support
provided.

5.2 Revisions and Enhancements:

McTrans reserves the right to make substantial revisions and enhancements to the Software and to market such
substantially revised versions as separate products. The End User shall not be entitled to receive such separate
products without additional charge. Upon the release of any such revised version of the Software, the obligation to
provide the above-described technical support services to the End User shall cease unless the End User chooses
to pay to license the enhanced version of the Software, regardless of whether the End User has previously
requested or received support on the prior version.

6. NETWORK USE:

The End User is strictly prohibited from using the Software on any network. This prohibition includes but is not
limited to the use of the Software either directly or indirectly through commands, data, or instructions transmitted to
or from a computer that is not licensed or is not part of the licensed internal network. This also includes any use for
Internet or web hosting services or by any user who does not hold a valid license for the Software from McTrans.

The Software is not designed for network use, and such use is unsupported. McTrans will not provide technical
support for any issues resulting from network incompatibilities or unauthorized network use.

7. RESTRICTIONS ON USE
The End User agrees that they shall not, nor shall they permit any third party to:
e Software Modification: Modify, adapt, translate, or create derivative works based on the Software, in whole
or in part, without the express prior written consent of McTrans.
e Reverse Engineering: Reverse engineer, decompile, disassemble, or otherwise attempt to derive the
source code of the Software, except to the extent expressly permitted by applicable law.
e Unauthorized Use: Use the Software for any purpose other than as expressly permitted under this
Agreement, including unauthorized copying, distribution, or dissemination of the Software.
e Intellectual Property Infringement: Engage in any activity that infringes on the intellectual property rights of
McTrans, including any unauthorized copying or distribution of the Software or associated documentation.
e Copying and Distribution: Copy, reproduce, or distribute the Software or associated printed documentation
for sale, distribution, or dissemination, except as expressly provided under the terms of this Agreement or
with the express prior written consent of McTrans.
e Documentation Use: Reproduce the associated documentation only as necessary for use within the
permitted scope of the subscription type as outlined in this Agreement.
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Ownership of Software Modifications:

Any modifications, adaptations, translations, derivative works, or any other products or materials resulting from any
prohibited actions shall become the exclusive property of McTrans, regardless of whether such actions were
performed with or without McTrans’ consent.

8. INTELLECTUAL PROPERTY RIGHTS:
The Software and all associated intellectual property rights are owned by McTrans. No rights are granted to the
End User other than the limited license expressly set forth in this Agreement.

9. USE OF RESULTS IN RESEARCH AND COMMERCIAL PUBLICATIONS:

McTrans grants the End User legal permission to use the results generated by the Software in academic, research,
or commercial publications, provided that such use complies with the terms of this agreement. The End User may
publish or present findings derived from the Software as part of their research or commercial work as long as the
Software is properly cited and all applicable license terms and restrictions are adhered to. Unauthorized
reproduction or distribution of the Software itself remains strictly prohibited.

10. TRANSFER RESTRICTIONS:

The Software is licensed only to the End User, and this License Agreement may not be assigned or transferred to
anyone without McTrans’ prior written consent. Any authorized transferee of this License Agreement shall be bound
by the terms of this License Agreement. The End User may not transfer, assign, rent, lease, sell, or otherwise
dispose of the Software except as expressly provided in this License Agreement.

11. LIMITED WARRANTY AND LIMITATIONS OF REMEDIES:

End User acknowledges and agrees that it is the sole responsibility of End User to fully understand the limitations
and assumptions underlying the Software and to refrain from using the Software without the assistance of personnel
with appropriate expertise. The End User accepts full responsibility for reviewing, interpreting, applying, and utilizing
the output of the Software and for ensuring that such output complies with any applicable design codes, standards,
or project specifications.

Except as expressly provided herein, the Software is provided “AS IS” without warranty of any kind, whether
expressed or implied, including, but not limited to, implied warranties of merchantability and fitness for a particular
purpose. McTrans does not warrant that the functions contained in the Software will meet the End User’s
requirements or that the operation of the Software will be uninterrupted or error-free. The entire risk as to the quality
and performance of the product is with the End User.

In no event will McTrans be liable to the End User for any damages, including any lost profits, lost savings, or other
incidental or consequential damages arising out of the use of or inability to use the Software, even if McTrans has
been advised of the possibility of such damages, or for any claim by any other party. The above warranty gives the
End User specific legal rights, and the End User may also have other rights in the United States, which vary from
state to state.

Use of the Software where the End User believes or has reason to believe that damage may occur constitutes a
violation of any and all warranties. McTrans has no knowledge of the hardware or Software configurations of the
End User and assumes no liability for their damage.
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12. TERMINATION:

12.1 Termination by McTrans:

McTrans may terminate this Agreement immediately upon notice if you fail to comply with any term or condition of
this Agreement. Upon termination, you must cease all use of the Software and destroy all copies of the Software in
your possession.

12.2 Termination by End User:
You may terminate this Agreement at any time by discontinuing the use of the Software and notifying McTrans. No
refunds will be provided for any remaining portion of the Subscription Term.

13. GOVERNING LAW:

This License Agreement shall be governed by the laws of the State of Florida, U.S.A. Venue for all disputes related
to this License Agreement shall be in the United States District Court of the Northern District of Florida, Gainesville
Division, or in the Circuit Court of the Eighth Judicial Circuit for Alachua County, Florida.

14. U.S. GOVERNMENT RESTRICTED RIGHTS:

The Software and associated documentation are provided with RESTRICTED RIGHTS. Use, duplication, or
disclosure by the U.S. Government is subject to restrictions as set forth in subdivision (c)(1)(ii) of The Rights in
Technical Data and Computer Software clause at 52.227-7013 or subparagraphs (c)(1) and (2) of the Commercial
Computer Software - Restricted Rights at 48CFR52.227-19. The contractor is McTrans, University of Florida, PO
Box 116585, Gainesville, FL 32611-6585.

15. EXPORT REGULATION:

The Software may be subject to U.S. export control laws and regulations, including the U.S. Export Control Reform
Act and its associated regulations. End User will not directly or indirectly export, re-export, transfer, or release the
Software to, or make the Software accessible from, any country, jurisdiction, or person to which export, re-export,
transfer, or release is prohibited by applicable U.S. laws and regulations. End User will comply with all applicable
laws and regulations and complete all required undertakings (including obtaining any necessary export license or
other governmental approval) prior to exporting, re-exporting, transferring, or releasing, or otherwise making the
Software available, outside the U.S. End User shall not export, re-export, transfer, or release the software or
software source code to any country which is comprehensively sanctioned by the U.S. Department of the Treasury,
Office of Foreign Assets Control (OFAC), as updated from time to time, which currently includes: Cuba, Iran, North
Korea, Syria, and the Donetsk, Luhansk, and Crimea regions of Ukraine.

16. SEVERABILITY:

If any portion of this License Agreement shall be declared void or a nullity by a court of competent jurisdiction, then
the remainder shall survive and remain in full force. Should you have any questions concerning this license, you
may contact the McTrans Center, University of Florida, PO Box 116585, Gainesville, FL 32611-6585, U.S.A., [1]
(800) 226-1013.
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TRANSYT-7F, and T7F are copyright University of Florida.
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CORSIM, NETSIM, FRESIM, TRAFED, TRAFVU, and TShell are copyright University of Florida, with
portions copyright ITT Industries, Inc., Systems Division.
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Getting Started

System Requirements

HCS is designed for standard Windows installations. For optimal performance, the system should be Windows 10
or newer. While HCS may be compatible with older versions of Windows, any installation and operational issues
arising from using these older versions will be the sole responsibility of the end user.

Getting Started

To begin, click on File then New (or the "New File..." button on the Start page).

Normal Windows keyboard and mouse functions are available. Tabbing, clicking to a new field, or pressing the
Enter key will trigger a recalculation and update the report.

Network Analysis

Network analyses will evaluate the interactions between freeways and urban streets and the effects of spillback
from one facility to another. This type of analysis can be applied to a network of interconnected freeways and to
freeway-to-arterial connections. It can also be applied when the freeway-arterial interchange consists of signalized
intersections, stop-controlled intersections, and roundabouts. These analyses will estimate travel times and speeds
for networks and for origin-destination pairs (O-D) within these facilities. The methodology and procedures of
application use the HCM Chapter 38 procedures.
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General Controls

Menu Items

New — Creates a new Network file (*.xnw) and starts a new analysis project; shortcut is Ctrl+N
Open — Opens an existing Network file (*.xnw); shortcut is Ctrl+O
Save — Saves an open Network file (*.xnw) using the current file name; shortcut is Ctrl+S
Save As... — Saves an open Network file (*.xnw) using a specified file name; shortcut is F12
Close — Closes an existing Network file (*.xnw); shortcut is Ctrl+W
Print — Brings up printer selection and prints a Network report to the printer or specified file type; shortcut is Ctrl+P
Print Preview — Displays preview of current report before printing; shortcut is Ctrl+F2
Report
Formatted Report — Displays formatted report including the most important values; shortcut is F4

Text Report — Displays text report with input, intermediary, and final results; shortcut is F6

Default Settings — Opens a dialog box for the user to input defaults for Analyst, Agency, and Jurisdiction, which
will be applied to all new files; also allows selection of USC or Sl units, which will be applied to all new files; shortcut
is Alt+F

Help

Contents — Provides access to glossary, acknowledgements, copyrights, and information on the HCM
procedures; shortcut is Ctrl+F1

Index — Allows user to search keywords within the glossary

Search — Allows user to search for any word within the glossary

User Guide — Opens a comprehensive user guide in PDF format; shortcut is Ctrl+G
HCM Reference Guide — Opens a reference guide for the HCM in PDF format

HCS Updates — Sends the HCS version number anonymously without any personally identifiable
information to McTrans to check for a newer version

HCM/HCS Training — Opens the McTrans Training Page in the default web browser to view the latest
training opportunities

HCQS Web Page — Opens the TRB Highway Capacity and Quality of Service Committee page in the default
web browser

Support

Frequently Asked Questions — Opens the McTrans support page for HCS in the default web
browser

HCS Overview — Opens the McTrans HCS Overview page in the default web browser
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McTrans Website — Opens the McTrans home page in the default web browser

E-mail McTrans — Composes a new e-mail addressed to McTrans in the default e-mail client with
registration number, serial key, module, and version number already populated in the Subject field

About HCS - Opens an about window with software version information, EULA, general
acknowledgements, and other relevant links

Exit — Exits the HCS Network module; shortcut is Alt+F4
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Network Analysis

HCM Chapter 38

The Highway Capacity Software (HCS) faithfully implements the methodology prescribed in the Highway Capacity
Manual (HCM) for analyzing the interactions between freeways and urban streets and the effects of spillback from
one facility to another. The methodology of this chapter can be applied to a network of interconnected freeways and
to freeway-to-arterial connections. It can also be applied when the freeway-arterial interchange consists of
signalized intersections, stop-controlled intersection, and roundabouts. The analysis tools of this chapter provide
travel times and speeds for networks and for origin-destination pairs (O-D) within these facilities.

The methodology builds on the analysis methods of individual points, and segments and points, and extends them
in several ways in order to consider spillback effects from the downstream facility. First, because spillback affects
each lane differently, the analysis is conducted on a lane-by-lane basis. Second, supplemental performance
measures are provided at the network level and at the O-D level for undersaturated and oversaturated conditions.
Travel time measures are also provided for segments and facilities, and their values are consistent with the analysis
methods described in other parts of the manual.

Operational Data
NETWORK

On the Network page, the user first enters the General Information into the respective fields: Analyst, Agency, Date,
and Time Analyzed. Then, the user enters the Site Information into the respective fields: Jurisdiction, Analysis Year,
and Project Description.

To run a network analysis, the user is required to load a freeway facility file. There are two options when using a
freeway facility file: Load Freeway Facility and Create Freeway Facility. The program requires the HCS Freeways
module for both these options. The Load Freeway Facility button opens a dialog that allows users to open an
existing HCS Freeways (*.xuf) file. The Create Freeway Facility button launches the Freeways module where a
user can create a new HCS Freeways (*.xuf) file. If HCS is already installed on the computer, then the Freeways
module should open when this button is clicked. If HCS is not installed, an error will pop up and HCS will need to
be installed on the computer to continue with the Network analysis.

Once a freeway facility is loaded, the Freeway Facility Information box will be displayed with the Fila Name, Number
of Segments, Number of Analysis Periods, and the Start Time. The data grid on the Network page will also populate
and a Network Segments graphic will display.

For the data grid, only on-ramp, off-ramp, weaving on-ramp, and weaving off-ramps from the loaded freeway facility
will display. For the graphic, the entire freeway facility will be illustrated along with nodes. Other relevant segment
information will be displayed. Columns in the data grid include the following: Segment, External File, Segment Type,
Ramp Terminal Type, Ramp Terminal Facility Name, Connected Intersection/Segment ID, Connected
Intersection/Segment Name, Approach, Ramp Roadway Length, and Details. Segment and Segment Type will
automatically populate based on the freeway facility loaded. Under External File, hyperlinks are provided to select
an external Streets (*.xuf) or Freeways (*.xuf) file to add as a node. Once selected, Ramp Terminal, Ramp Terminal
Facility Name, Connected Intersection/Segment ID, Connected Intersection/Segment Name, and Approach will
populate based on the file selected. Ramp Roadway Length can be edited with or without an external file selected.
Clicking on any of the Details hyperlinks will open the Details page for the corresponding ramp terminal.
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Above the data grid, two buttons and a checkbox are provided. If changes were made to any of the external files,
the row(s) of those external files can be selected, and then the ‘Refresh Selected Files’ button can be clicked. This
will reload the selected external file(s) so the most up-to-date information will be used. If the user desires to remove
any of the already loaded external files, the row(s) of those external files can be selected, and then the ‘Remove
Selected Files’ button can be clicked. This will remove the external file(s) so it is no longer a connection to the
network. When the checkbox ‘Assign Tamp Terminal Volumes to all Freeway Ramp’ is checked, all checkboxes for
‘Assign Ramp Terminal Volume to Freeway’ for individual ramp terminals on the Details page will be checked.

DETAILS

On the Details page, all ramp terminals will have the following sections: Ramp Terminal Data, Ramp Details, Volume
Balancing, and Freeway Inputs. Ramp Terminals that are either Off-Ramp or Weaving Off-Ramp will also have an
additional section of Off-Ramp Lane Assignment.

Under the Ramp Terminal Data section, drop-down selections are provided for Ramp Terminal and Analysis Period.
These selections will determine what inputs are displayed on the page. This section also displays the Ramp
Terminal Type, Ramp Terminal Facility Name, Connected Intersection/Segment Name, Connected Approach, and
a Network Segments graphic.

Under the Ramp Details section, inputs required for Off-Ramp and Weaving Off-Ramp are the Ramp Roadway
Length and Shoulder Queue Storage Lengths. Inputs required for On-Ramp and Weaving On-Ramp are the Ramp
Roadway Length, indication if Ramp Metering is present, and the Ramp Metering Rate if applicable.

Under the Volume Balancing section, the Ramp Terminal Approach Volume and Ramp Demand values are
displayed. When the checkbox ‘Assign Ramp Terminal Volume to Freeway’ is checked, the Ramp Demand will
automatically update to use the Ramp Terminal Approach Volume instead. This checkbox is only available when
there is an external file loaded for the ramp terminal.

Under the Off-Ramp Lane Assignment section, the Connected Intersection/Segment Name and Connected
Approach information is displayed. The off-ramp lane assignment can be specified through a drop-down selection.
This available based on the external file loaded for the ramp terminal and the number of lanes.

The Freeways Inputs section is in a collapsible menu. What is included is dependent on the corresponding segment
from the freeway facility originally loaded. All inputs are directly taken from the Freeways file, but are editable within
Network

Network Analysis Report

The report page shows a formatted version of the analysis in a dynamic form, reacting to changes in the Network
page. All or a portion can be copied to the Windows clipboard for insertion into other files by right-clicking into the
report and selecting Copy.

Both formatted and text reports are available for viewing and printing. The formatted report provides data and results
that are most important to the user, and are displayed in a clean and more presentable fashion. The text report
provides more details to the user, rather than a summary.

The user can switch between reports by clicking on the button found at the bottom of the Report page.
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How To

Create a New File

1. From the Start screen, there are three options for creating a new file:

Start N Help
New File... Topics

Open File... NETWORK HCS Updates
Example Folder... HCS Overview
Recent McTrans Website
“M/HCS Traini
E-mail McTrans
About HCS
Y2 HCS2025
rans ion Insti /
omveervoronns. | NICTFANS
Copyright © 2024 University of Florida. All Rights Reserved. HCS™ Network Version 2025
Note: A new file can be created if an existing file is already open; you do not need to start from the Start
screen.
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a. Selecting File > New from the main menu; this can be found by selecting the three lines in the top
left-hand corner of the screen and then selecting “New”

-
N HCS Network

New
Open
Example Folder
Save

Save As
Close
Units

Print

Print Preview
Report

Default Settings
Help

Exit

= (m] X

Ctrl+N
Ctrl+O
N Help
Topics
: NETWORK HCS Updates
HCS Overview
A McTrans Website
proue HCM/HCS Training
E E-mail McTrans
Alt+F4 About HCS
ya HCS2025
Tansportstion nstivue| NICTFANS 4

Copyright © 2024 University of Florida. All Rights Reserved. HCS™ Network Version 2025

b. Selecting “New File...” from the Start screen; this can be found below in the red box

N HCS Netwark

Start Help
Topics
Open File... N ETWORK HCS Updates
Example Folder.. HCS Qverview
Recent cTi bsi
C raini
E-mail McTrans
About HCS

¥ HCS2025
e McTrans /

Copyright & 2024 University of Florida. All Rights Reserved. HCS™ Network Version 2025

c. Using the keyboard shortcut “Ctrl+N”
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2. Once a new file is created, you will be brought to the Network page

N Networklow® -H

= START NETWORK DETAILS RESULTS REPORT

Project Properties

Analyst Jurisdiction

Agency Time Analyzed

Analysis Year 2024 Date 9/29/2024

Project Description Units US. Customary
Load Freeway Facility Create Freeway Facility

Assign Ramp Terminal Volumes to all Freeway Ramps []

Segment _ External File Segment Type  Ramp Terminal Type Ramp Terminal Facility Name Connected Int/Seg. ID _Connected Int./Seg. Name Approach  Ramp Roadway Length, ft_ Details

Copyright © 2024 Universiy of Florida. All Rights Reserved. HCS™ Network Version 2026

Open an Existing File

1. From the Start screen, there are six options for opening an existing file:

Start Help
New File... Topics

Open File... N ETWORK tIQS_uadalgs

Recent McTrans Website

ya HCS2025
Tansportation insitute| N GTF@NS

Copyright © 2024 University of Florida. All Rights Reserved. HCS™ Network Version 2025

Note: A file can be opened even if another file is currently open; you do not need to start from the Start
screen.
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a. Selecting File > Open from the main menu; this can be found by selecting the three lines in the top
left-hand corner of the screen and then selecting “Open”
rN HCS Network

New Ctrl+N

Open Ctrl+O
Example Folder

Save

Save As 1 Help
Close A Topics
Units > Hg-s_up_dm
NETWORK
Print 5
HCS Overview
Print Preview
McTrans Website
Report »
Default Settings Alt+F HCM/HCS Training
Help > E-mail McTrans
Exit Alt+F4 - About HCS
4 HCS2025
T rtation Institut 7_ 4
u::‘vs[»P:S|Tavl:;‘rL:;:nt:\E Mc rans 4

Copyright © 2024 University of Florida. All Rights Reserved. HCS™ Network Version 2025

b. Selecting “Open File...” from the Start screen; this can be found below in the red box
N HCS Netwark ==

Start 4 Help

Open File... NETWORK HCS Updates
Example Folder. HCS Overview
Recent cTi bsi
C raini
E-mail McTrans
About HCS

»Z HCS2025
| ramsportation nstitoe) A STEA S V4

Copyright & 2024 University of Florida. All Rights Reserved. HCS™ Network Version 2025

c. Using the keyboard shortcut “Ctrl+O”
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d. Selecting a file under the Recent files list from the Start screen; this can be found below in the red

box
i HCS Network — O N

NETWORK HIS s
Example Folder.. HCS Overview
Recent cTl bsi
work1-Gainesvillel... C raini
Network3-Miamil75.x.. E-mail McTrans
About HCS
Y HCS2025
>

Transportation Institute | M ﬁ
UNIVERSITY of FLORIDA c rans

Copyright @ 2024 University of Fiorida. All Rights Reserved.

HCS™ Network Version 2025

Selecting File > Example Folder from the main menu; this can be found by selecting the three lines
in the top left-hand corner of the screen and then selecting “Example Folder”. Opening the example
folder will open the path of the HCS example files in File Explorer. The desired example file can be
double-clicked or right-clicked and selecting ‘Open’, which will open the example file in the Network
program.

f N HCS Network = [m} X
New Ctrl+N
Open Ctrl+O

| Example Folder

‘ Save
Save As Help
Close A N Topics

‘ Units >

e NETWORK Hestpd
Print Preview HCS Overview
Report > McTrans Website
Default Settings ~ Alt+F HCM/HCS Training
Help » E-mail McTrans
Exit Alt+F4 About HCS

Ya HCS2025
hettsrtionl] ' (o7 /274 4

HCS™ Network Version 2025

Copyright © 2024 University of Florida. All Rights Reserved.

Selecting “Example Folder...” from the Start screen; this can be found below in the red box.
Opening the example folder will open the path of the HCS example files in File Explorer. The
desired example file can be double-clicked or right-clicked and selecting ‘Open’, which will open
the example file in the Network program.
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Recent

U

Copyright @ 2024 University of Florida. All Rights Reserved.

NETWORK

-4 HCS 2025
VERSITY of FLORIDA MC]rans

| Transportation Institute |
|

HCS™ Network Version 202

N Network1-Gainesvillel75.xnw - HCS Network

Once an existing file is opened, you will be brought to the Network page

- 8 X

= START NETWORK DETAILS RESULTS REPORT

Project Properties

Analyst
Agency
Analysis Year

Project Description

2024

Jurisdiction

Time Analyzed

Date

Units

9/9/2024

US. Customary

Load Freeway Facility

Create Freeway Facility

Freeway Facilty

File Name.

Network!-175NBGainesvilleFLxuf

Number Of Segments 19

Number Of Analysis Periods 4  Start Time  08:00

Remove Selected Files

Assign Ramp Terminal Volumes to all Freeway Ramps []

Segment  External File SegmentType  Ramp Terminal Type  Ramp Terminal Facity Name Connected Int/Seg. D Connected Int/Seg. Name Approach _ Ramp Roadway Length, t _Details J
2 e ofiRamp _[signal W Willston Road s 75 NB On-/Of-Ramp [se 5280 e -)
T = Onfamp_[Sgnal SW Willston Road B 75 NB On- /O Rarmp F_g 5280 ot
5 Off-Ramp Signal SW Archer Road 3 175 NB On-/Off-Ramp Ne 5280
O On-Ramp Signal SW Archer Road B 1-75 NB On-/Off-Ramp. s8 5280
5 Networkt New Grams[Sonal Wilewbery Rosd 0 75 N6 on-/O Ramp e ED
0 u O Romp [Sgnal W 39 Avene 5 75 56 On/Of-Ramp Tne 5280
78 [Networki 39t On-Ramp Sgral W 39t Avenue B 175 58 On-/Of-Rarmp ss 5280 Detais

Network Segments

Segmentld  seg. 1 Seg. 2 seg. 3 Seg. 4 Seg. 5 seg. 6 seg. 7 seg. 8 seg. 9 seg. 10

Basic OffRamp Basic on-Ranp Basic 0ff Ramp Basic on-Ramp Basic Basic

Length. ft 220 1500 90 1500 1600 1500 1800 1500 300 5385

Node Id Node 3 ode 3 Hode 3 Hode 3

Node @

[ —

Copyright © 2024 University of Florida. All Rights Reserved.

HCS™ Network Version 2025
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Save a File

1. There are five options for saving an open file:

a.

Selecting File > Save from the main menu; this can be found by selecting the three lines in the top

left-hand corner of the screen and then selecting “Save”

N Networklxmw” - HCS Network

- 0 X

= START NETWORK DETAILS RESULTS REPORT

New
Open
Example Folder

Project Properties

Jurisdiction

—— Time Analyzed

Save Ctri+S

Save As. 2024 Date 9/29/2024
Close Uniits US. Customary
Units

print

Print Preview

Report , Load Freeway Facility Create Freeway Facilit

Default Settings

Help

it

Segment _ External ile

Segment Type

Copyright © 2024 University of Fiorida. Al Rights Reserved.

Ramp Terminal Type  Ramp Terminal Facilty Name

Assign Ramp Terminal Volumes to all Freeway Ramps [7]

Connected Int/Seg. 1D Connected Int/Seg. Name Approach _ Ramp Roadway Length, ft__ Details

Selecting File > Save As... from the main menu; this can be found by selecting the three lines in

the top left-hand corner of the screen and then selecting “Save As...”

N Networklxnw” - HCS Network

= START NETWORK DETAILS RESULTS REPORT

New

pen
Example Folder

Save

Save As, 12
Close

Units

Print

Print Preview

Report

Default Settings

Help

Reiresh Selected Fies

Bxit

ent _External File

Copyright © 2024 Universit of Florida. Al Rights Reserved.

tamp Terminal Type Ramy

Project Properties
Jurisdiction
Time Analyzed
Date 9/29/2024

Units US. Customary

Create Freeway Facility

Assign Ramp Terminal Volumes to all Freeway Ramps []

i Terminal Facilty Name. Connected Int/Seg, ID  Connected Int/Seg. Name Approach  Ramp Roadway Length ft_ Details

C.

Using the keyboard shortcut “Ctrl+S” for Save

d. Using the keyboard shortcut “F12” for Save As
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e. Exiting the program or closing the file without saving changes beforehand; this will prompt you to
save changes to the file before anything is closed

HCS Network X

"o' Save changes to Network1.xnw?

Yes No Cancel

i. Selecting “Yes” will save the file if it is an existing file. If the file has not been previously
saved, the Save As dialog box will pop up allowing you to change the file name and save
it.

ii. Selecting “No” will exit the program or close the file without saving the file

iii. Selecting “Cancel” will prevent the file from closing

Note: Using Save with an existing file will save a file without prompting you to specify a file name. Using Save with
a new file will bring up the Save As dialog box for you to specify a file name for saving. Using Save As will always
bring up the Save As dialog box for you to specify a file name for saving.

Close a File

1. There are three options for closing an open file:

a. Selecting File > Close from the main menu; this can be found by selecting the three lines in the top
eft-hand corner of the screen and then selecting “Close”

- o0 X

pen

Save As 2024 Date 9/29/2024

Close Curl+W Units US. Customary

te Freeway Facility

Assign Ramp Terminal Volumes to all Freeway Ramps (7]

Terminal Type  Ramp Termina Facilty Name Connected Int/Seg. 1D Connected Int/Seg. Name Approach _ Ramp Roadway Length,ft D¢

b. Using the keyboard shortcut “Ctrl+W”

c. Exiting the program itself; please see How To: Exit the Program
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Exit the Program

1. From the Start screen, there are three options for exiting the program:

Start Help

Open File... NETWORK HCS Updates
Example Folder... HCS Overview
Recent McTrans Website
CM/HCS Traini
E-mail McTrans
About HCS

»% HCS2025
Tansporation nstivte| N ST RS 4

Copyright © 2024 University of Florida. All Rights Reserved. HCS™ Network Version 2025

Note: The program can be exited even if a file is still open; you do not need to start from the Start screen.

a. Selecting File > Exit from the main menu; this can be found by selecting the three lines in the top
left-hand corner of the screen and then selecting “Exit”
rN HCS Network - [m] X
New Ctrl+N
Open Ctrl+O
| Example Folder
Save
Save As Help
Close W Topics
Units »
e NETWORK HCS Updates
n :s ; .
Print Preview
McTrans Website
Report »
Default Settings Alt+F HCM/HCS Training
Help > E-mail McTrans
Exit Alt+F4 About HCS
Y4 HCS2025
n rtation Institut /
U:RJSS;’SI;I;"FLI&:&Q MC’I' ans :
b. Using the keyboard shortcut “Alt+F4”
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c. Selecting “X” in the top right-hand corner of the screen; this can be found below in the red box

Open File.. NETWORK HA
! der. HCS Overview
Recent cTl bsi
C raini
E-mail McTrans
About HCS
Y2 HCS2025
| Transportation Institute | y
INivé’R;:'I:rnfr:,m:l:z: | MC] rans -")

Copyright & 2024 University of Florida. All Rights Reserved. HCS™ Network Version 2025

Edit the Default Settings

1. From the Start screen, there are two options for editing the Default Settings:

Start Help
New File... Topics

Open File... NETWORK HCS Updates
Example Folder... HCS Overview
Recent McTrans Website
- S Traini
E-mail McTrans
About HCS

%z HCS2025
| MCTFENS i

Copyright © 2024 University of Florida. All Rights Reserved. HCS™ Network Version 2025

Note: The Default Settings can be changed even if an existing file is already open; you do not need to start
from the Start screen.
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a. Selecting File > Default Settings from the main menu; this can be found by selecting the three lines

in the top left-hand corner of the screen and then selecting “Default Settings”

-
N HCS Network

= 0 X
New Ctrl+N
Open Ctrl+O
Example Folder
Save
S N Help
Close Topics
Units »
NETWORK HEs Hjsiains
S e HCS Overview
Report , McTrans Website
Default Settings Alt+F HCM/HCS Training
Help » E-mail McTrans
Exit Alt+F4 About HCS
¥  HCS2025
oviemvorous | MICTFANS

Copyright © 2024 University of Florida. All Rights Reserved. HCS™ Network Version 2025

b. Using the keyboard shortcut “Alt+F”

2. Opening the Default Settings will cause a Default Settings window to pop up:
N Default Settings X

Analyst
Agency
Jurisdiction
New File Default Units
® ysc

O Metric

Cancel

3. You can specify Analyst, Agency, and Jurisdiction by clicking in the corresponding text boxes and typing
the desired text. You are also given the option of running the analysis in either U.S. Customary (USC) or

SI (Metric) units.

4. Clicking “OK” will save the changes made and close the Default Settings window; clicking “Cancel” will

close the Default Settings window without saving any changes.

5. When a new file is created, the Analyst, Agency, and Jurisdiction fields will automatically be populated with

the text specified in the Default Settings.

6. Whether starting a new file or opening an existing file, the inputs and results will display according to the

units specified in the Default Settings.
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View Results of the Analysis
1. After editing all the necessary inputs, results of the analysis can be found in the form of pages and reports.
Reports can be found on the Report page.
2. There are two options for pages: Results and Report

a. On the Results page, Ramp Terminal Data, Ramp Roadway Report, On-/Off-Ramp Spillback
Report, and Speed and Density sections are provided for each individual segment.

 Nei %
S START NETWORK DETAILS RESULTS REPORT

Ram,
Seg. 2 Off-Ramp> SW Willsion Road 1000715
Sgral W Willston Roxd
1475 4B On-/0HT-Ramp @
Facity Upstream Demand
, ) .
W ®_@ @ E
Ramp Roadway Report
Ramp Roadway Length, ft 5280 Ramp Roadway Speed. mi/h 331 Ramp Roadway Travel Time, s 1134 Ramp Roadway Capacity, poh 2000
Off-Ramp Spillba
Of-Ramp Demand, peh 40 No No Spilback
Ramp L1 (R) Queue, 10 Ramp L1 () Quee Storage Ratio 003 0
Ramp L2 () Quee, 1 Ramp L2 (1) Queve Storage Rato. -
Speed and Density
- Prop. Freeway Vehicles in Lane 1 and 2 0615 32m
1697 Speed Index (DS) oar2 h 596
80 Average Speed (5), mi‘h 654 Density in Ramp Infl. Area (DR), pc/mi/in 246 Level of Service, LOS c
s Average Density, pe/mi/in 50

Copyrioht €024 University o Flesiga Al Rights Rescrves HES™ Network Version 2025

i. Under the Ramp Terminal Data section, you can specify which ramp terminal within the
facility to display by selecting the specific ramp terminal in the drop-down menu. Similarly,
the analysis period can be specified by selecting it in the corresponding drop-down menu.

N Network!-Gainesvle7Smw” - HCS Network - 8 x
S START NETWORK DETAILS RESULTS REPORT

Ramp Terminal Data

Ramp Terminal iod 0700-07:15

Ramp Terminal Type al Facilty Name SW Archer Road

n-Ramp> SW Willston Roa
Connected Int/Seg. Name Seg. 6 Off-Ramp> SW Archer Road
Seg. 8 On-Ramp> SW Archer Road
Seg. 11 Off-Ramp> W Newberry Road
Seg. 13 On-Ramp> W Newberry Road
Seg. 16 Off-Ramp> NW 39th Avenue

Seg. 18 On-Ramp> NW 39th Avenue

Connected Approach N8

Facility Upstream Demand

s -
ek 4
e @
—
O ) ®—0@—0® e
Romp Roaduay Length, 20 Romp Roaduay Specdmil 336 welTimes 1113 Romp Roadvay Capaciy,pch 2000
Off-Ramp Sp
Of Ramp Demand peh m Adsted Of-Ramp Demand,peh 371 Spibad o Silacksource No Spiback
Ramp L1 () Queue s Ramp L1 8Tl StoageLengt . 6280 Romp L1 () Queue Siorage R 007 Ramp1 0 Come ergh Pt
e e i N ot Ramp L2 (1) Queue Lengh Post
rap 203 e Ramp L2 ) Toa Strage Lngih Ramp L2 1) Quve torag o Ramp 120 cum
%05 ooun Tnd2 oss P 2,00 02
552 SE———— R nfuence Spee (8. mirh
806 Average Speed (5), mi/h 5.7 Density in Ramp Infl. Area (DR), pe/mi/ln  25.2 Level of Service, LOS c

26 Average Density, pe/mi/in 231

(Copyright ©2024 Universty of Florda. All Rights Reserved.

b. The Report page can display the Network formatted report, Network text report, or O-D formatted
report.
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e

= START NETWORK DETAILS RESULTS REPORT

HCS Network Report

ot Date sz
“Ageney Analysis Year 2028
s T Arabyeed
Tecity ome e T 5 oy
Profec Descrigon
Goometry
‘Segment Ramp Type ‘Ramp Terminal Faclity Name Connected Node/Segment | Connected
‘Number Type Approach
p ) Sgnat S il [
] G, e S wilsion Bosd V7 N Onjor Ramp |5
5 i ramp Signal SW Arciver Poad 1775 NE Gn /OF Ramp NE
s end S S A Rt s e Ovjor sy |
11 Off-ramp Signai W Newberry Road 175 N8 On-JOfi-Ramp. NE
5 Gn-ramp Signa W Newberry Road 175 NB Gn-/0tt-Ramp s
. v e =) w3 v T
(<) N Grrams Sona w350 e s ston it | S8
7 [Siliback Analysis and Gueses
Analysis Period 1 (97:00-07:15)
Ramp Humber 1 z 3 4 5 5 7 " s | 10
e e s [ [ [=]™
Rarnp Tommeat o | one | ora | one | oe | ona | om | own
Tare o Tioe w58 e [m [ w [ = [ [ = Z
bt of Famp Laves Il EEEE EEERE
[T ey Camaciy ey 2000 | 200 | 2000 | 200 | 7000 | av0 | woom | 2o
Rarnp Dermard, o8 /) o | a6 | o | v | w | o | w0 | @
| Adjusted Ramgp Demand, vRad) (pcrhy 4% 146 an 12 55 665 380 160
Hamp Meterng? Mo | Mo | me | to | no | e | wo | mo
Ramp Metering Rate (po/h)
Splback Oocurst o | to | Mo | o |t | wa | w0 | W
Ramp L1 (R) Queue fveh) kR ] 00 175 00 231 00 0.0 0.0
Warp L2 ) Queve (e ™
Rarmo L1 0 Quse T wl o [ o = [ v«
Rarnp L2 ) Queue 1 3 s

There are three options for reports:

Network Formatted, Network Text, and O-D Formatted

Formatted reports show the most important results in a presentable format

HCS Network Report upste, | 277 | 282 | 144 46 58
an - da] - 19 33
ject Information T
e as = | = 128 = 29 = e} = = E 5 2 = =
Analyst Date 9172022 +
- 7 B = - = E (%3 = S - E = E 5
Agency Analysis Year 2022 |
7 B - B B B B B - B B , R , N
Jutistiiction Time Analyzed
Legend
Faciity Name 175 58 - Miami, FL Units U, Customary -
Origin Destination
Projoct Dascription Miami - 75 SB @ SR-826 Interchange -
Frvy. Upstream freeway Segment 1 -
Geometr
i Seg. 4N [Hialeh Gardens Bivd] 1381h 5t G Hialeah Seg. 2N [Hialeh Gardens Blvl] 13810 51 @ Haleah
Segment Ramp Type Ramp Terminal Facility Name Connected Node/Segment | Connected Ga Garclens Blvd.
Number Approach T . ; .
Seg.4s inleh G Bivel] W B4th St Seg.25 Hinleh Gardens Blvd] W 84th St
2 Oft-ramp Signal Hialeh Gardens Blvd 138th 5t @ 5B = illeh Gardste v = et olel)
Blvdl Seg.7 Wo Ramp Terminal Seg. 4 [SR-826 5B Seg, 4 5R-826 56 - Seg 4 - Basic
4 Weaving On ramp. Signal Hialeh Gardens Bivd 56058 Hilean Gargens | p PR N Rag el
7 Wezving Ol ey - SR-876 58 - Seg 7 - Merge N E Frwy. Downstream Freeway Segment 8
B Off-ramp E Messages
i On-ramp = = = = Warming 1 ‘Queue spillback occurs in at least one ramp in at least one analysis period. Therefore,
Spillback Analysis and Queues reported 0-D travel times may not be refiable
Analysis Period 1 (07:00-07:15)
Ramp Number 1 2 3 4 5 6 7 8 9 10
Segment Number z 4 4 5 7 - = = =
Ramp Terminal OFR | WONR | WOFR | OFR ONR
Ramp Terminal Type §6 | SI6 | FRWY
Number of Ramp Lanes 2 1 z 1 1 -
Ramp Roachway Capacity (perh) 4200 | 2100 | 4200 | 2100 | 2100 | - 5 z B z
Ramp Demand, vR (pc/h) 1008 &51 2626 420 368 = - = -
Adjusted Ramp Demand, vRad] (pe/h) 1008 | 651 | 2626 | 420 | 368
Ramp Metering? No Mo No No Ne.
Ramp Metering Rate (pe/h) z = E B = = = = =
Spillback Occurs? Ves | Mo | No | No | No | - - = -
Ramp 11 (R} Queue {veh) 08 | 157 | 418 = o - = = 5
Ramp L2 (1) Queue (veh) 1430 s | - S = B =
Ramp L1 (R) Queue (fty o 408 3688 = - - - = =
Ramp L2 (L} Quexe (ft) e | - | e8| - = - - . .
Average Vehicle Spacing (f) 260 | 260 | 260 | - 5 = = = =
Ramp L1 (R) Total Storage Length (1) iss0 | 2630 | 3780 - - E
Ramp L2 (L) Total Storage Length (ft) 2700 3780 -
Ramp L1 (R} Gucue Storage Ratio 000 | 016 | 0%
Ramp 12 (1) Queue Storage Ratio 138 = as8 = = = = = > 5
Ramp L1 (R) Quenie Length Past Ramp Storage () | 0 a o E E = z
Ramp L2 (1) Queue Length Past Ramp Storage () | 1018 0 - - = -
Origin-Destination Pairs Travel Time (Min) - Analysis Period 1 (07:00-07:15)

origin |

Destination Node

Node TN [ 25 ] &

I

=

Towmee] = [ ]
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b. Text reports show a more detailed analysis in plain text

4. The type of report displayed can be changed by using the main menu items, keyboard shortcuts, or toggle
buttons found under the report

a. Main Menu ltems

i. To switch to the Formatted Report, select File > Report > Formatted Report from the main
menu; this can be found by selecting the three lines in the top left-hand corner of the
screen, hovering over “Report”, and then selecting “Formatted Report”.

) Networ-GainesilelTSame - HCS Nebork = e %

= START NETWORK DETAILS RESULTS REPORT

2 HCS Network Report

Date. 97972024

Analysis Year 2004

e 175 N6 - Gaineswille, FL Units Us. Customary.

| Formatted Report 74

Sl b T Tt Report R Faclty Name Connected Node/Segment | Connected
Type Approach

Help > famp. Signal SW Willston Road 175 NB On-/Off-Ramp )

Bit AtsFa poamp Sognal SW Wilston Road 175 N6 on/Of-Ramp s

0 Offramp Signat 175 N6 On-/Oft-Ramp [

s m Signal 175 N8 On/Of-Ramp s

[ Oftramp Signal 175 N8 O /Of Ramp [

() on-ramp Signal 175 N6 On-/OffRamp s

G Ot ramp Signal W 3900 Avene 17558 On- /i Ramp [

(<) 0 Onamp Signat AW 35t Avenue 175 58 On /Of-Romp s

. |spillback Analysis and Queues
o ‘Analysis Period 1 (07:00-07:15)
Ramp Number v 23 [ 456785
2 [ 4 |6 o [ v B [w]|®

OFR | ONR | OFR | ONR | OFR | ONR | OFR | ONR

si6 | si6 | s6 | s | s | s6 | s6 | s6

[ 1 1 1 1 2
2000 | 2000 | 2000 | 2000 | 2000 | 2000 | 4000 | 2000

4s0 | 145 | 311 | 1132 | 955 | 665 | ow0 | 160
490 | 146 | 311 | 1132 | 955 | e6s | 980 | 160

No | No | No | No | No | No | No | No

No | No | No | No | No | No | No | No

71 | 00 | 175 | 00 | 231 | oo | o0 | oo
00

0 | o |45 | o [ser | o | o | o
o

Network User Guide How To - 25



To switch to the Text Report, select File > Report > Text Report from the main menu; this
can be found by selecting the three lines in the top left-hand corner of the screen, hovering
over “Report”, and then selecting “Text Report”.

N Networki-Gainesvillel7S.xnw* - HCS Network = a X

HCS. Network Text Report

sows A<
Close sporsens
unis

it : 0.5 Customary
it Prview

Report | Fomated Report__ 7
Default Settings  AILF Text Report

T oFR o

Yes ves ves
Bt Atspa pal  sigal  Signal
s o B e s
Approach 58 s e e e 8 e e
Lanes 1 1 1 1 1 2 1

On-Ramp Spillback Analysis

= Intersection Outbound Exiting Flow, veh/h sa=
H s 5 s

143 - 1263 - 52
: e : e

e - e - e
e - e - e

msesseszessesess  Outbound Exiting Flow From Left Tumn, veh/h ssssssessemsesssss
PeRamp 1 2 3 s H 6 7 s
1 4 770 279 - e
2 e - e e e
H e e e e
s e e ° °
fr— Outbound Exiting Flow From Through, veh/h

PeRamp 1 2 3 s H 5 s
1 e e e e
2 o e o °
3 ° e e °
s e e e e

b. Keyboard Shortcuts

Formatted Report: keyboard shortcut is “F4”
Text Report: keyboard shortcut is “F6”

c. Report Toggle Buttons

Toggle buttons are available at the bottom of the screen underneath the report.

If the Network formatted report is currently being displayed, the first toggle button will say
“Switch to Text Report” which will allow you to display the Network text report if clicked.
The second toggle button will say “O-D Report” which will allow you to display O-D
formatted report if clicked.

= START NETWORK DETAILS RESULTS REPORT

Data a0

Analyss vesr 2024

Time Analzea

L LS. Custoriny
Ramp Torminal Faciity Nare ‘Connected Node/Segment | Connred
Type Approach
Sl 75 ik O o 0
Sgeal )
i [
s
e
)
e
0 Gn o 5
Spillback Analysis and Queties.
‘Analysis Period 1 (97:00-07:15)
Ramp Number v [ 2 ]3[4+ s]e]z[s]5s]mw
s [ N
orm | onw | om | ows | om | owa | om | owe

56 | %6 | o6 | & | sc | 86 | o6

000 | 000 | 000 | 2000 | 200 | 2000 | <000 | a0
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ii. If the Network text report is currently being displayed, there will be one toggle button which
will say “Switch to Formatted Report”. This will allow you to display the Network formatted
report if clicked.

HCS Wetuork Text Resort

9/5/7028

U5, Custonary

essssmssssssss  Outbound Exiting Flow Fren Through,
e 3 [ H

veh
&
[
0
s
e

iv. If the O-D formatted report is currently being displayed, the first toggle button will say
“Switch to Text Report” which will allow you to display the Network text report if clicked.
The second toggle button will say “Network Report” which will allow you to display the
Network formatted report if clicked. There are also two drop down menus. The first allows
the selection of which analysis period to display. The second allows the selection of which
O-D pair to display.

HCS Origin-Destination Report
Aoy e )
Time Arahasd
R US Contormry

0-D Travel Time Report (07:00-07:15)
AW - 6E
‘Sapment Name oe D Travel Time ()| Crmulative Trave| Time
2]

W A1t B #7558 O 0N ) T

TR Gn T
152 s

(¢ 56 a5
. 5 W7

61.00-0715 1AW-26E
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5. The magnification of the report currently being displayed can be changed using the zoom slider found at

the bottom right-hand corner of the screen.

£  START NETWORK DETAILS RESULTS REPORT

ork Repo
Project
Analyst Date /972024
Agency Analysis Year 2028
Jurisdiction Time Anatyzed
Faciity Name 1-75 NB - Gainesvile, FL Units US. Custamary
Project Desciiption
Geometry
Segment Ramp Type Ramp Terminal Facility Name Connected
Humber Type Approach
i oft-amp signal SW Williston Road 175 N On-/Off-Ramp S8
4 On-ramp Signa SW Williston Road 1-75 NB On-/Off-Ramp )
[ Gft-ramp signal SW Archer Road 175 NB On-/Off Ramp NB
& on-ramp Signal SW Archer Road 1-75 N8 On /Off-Ramp s8
1 Of-ramp Signa) W Newberry Road 1-75 N8 On-/Off-Ramp NB
O ramp. Sianal W Newberry Road 175 NO On /O Ramp 0
6 Oft-ramp Signal NW 35th Avenue 175 5B On /O Ramp Ne |
) On-ramp Signa) N 39th Avenue 1-75 58 On-/Off-Ramp s8
Spillback Analysis and Queues
Analysis Period 1 (07:00-07:15)
Ramp Number ' 2 F] 4 s 3 7 8 ] 10
‘Seqment Number 2 [ 5 [ EIEIE .
Ramp Terminal ot | onk | ofm | one | o | on | om | one
Ramp Terminal Type S6 | %6 | 56 | 56 | 56 | s6 | si6 | s
Number of Ramp Lanes [ 1 1 1 [ 1 2 1
Ramp Raacway Capacity (pc/h) 2000 | 2000 [ 2000 | 2000 | 2000 | 2000 | 4000 | 2000
Ramp Demand, vR (pe/h) a0 | we | s | vz | ess | ees | e | ven
‘Adjusted Ramp Demand, viad) (pe/h) a0 | w6 [ am [ o2 | s | oees | om0 | a0
Ramp Metering? no | N0 [ no [ e [ ne [ Mo [ mo | e
Ramp Metering Rate {pe/n)
spillback Dccurs? no [ no [ o [ o [ o [vo [ o [
Ramp L1 (R) Queue (veh) 71 | o0 [ 175 ] oo [ 230 [ 00 [ 00 | 00
Ramp L2 (1) Queue (veh) 20
Ramp L1 (R) Queus (1) 1w | o [ ] o |sr| 0 0 [
Ramp 12 (1) ueue (1) o

To zoom in, drag the slider to the right; to zoom out, drag the slider to the left

Clicking the plus (+) button will zoom in; clicking the minus (-) button will zoom out

Holding down “Ctrl” on the keyboard and scrolling up on the mouse wheel will zoom in; holding
down “Ctrl” on the keyboard and scrolling down on the mouse wheel will zoom out

Print a Report

1.

a.

There are four options for printing a report:

Selecting File > Print from the main menu; this can be found by selecting the three lines in the top
left-hand corner of the screen and then selecting “Print”

N Networkl-Gainesvillel7Sxnw" - HCS Network = o X

New
HCS Network Report

Open
Example Folder

Save
Save As. Date 9/9/2024
Close Analysis Year 2024
Units , Time Analyzed
e G 175 NB - Gainesville, FL Units U Customary
Print Preview Cti+F2
Report
DefaultSettings  AlF PPTIPe Tkl Facility Name e
Help * H-ramp Signal SW Williston Road 1-75 NB On-/Off-Ramp S8
Bxit AlteFa prramp Signal SW Willston Road 175 N8 On-/Oft-Ramp S8
6 Off-ramp. Signal SW Archer Road 175 NB On-/Off-Ramp Ne
s On-ramp signal SW Archer Road 175 NB On-/Oft-Ramp s
n Off-ramp. Signal W Newberry Road 175 NB On-/Off-Ramp Ne
[0 On-tamp Signal W Newberry Road 175 NB On-/Oft-Ramp s
~ 3 Ott-ramp Signal W 39th Avenue 175 56 On-/Oft-Ramp [
18 On-ramp Signal W 39th Avenue 175 58 On-/Oft-Ramp s
Spillback Analysis and Queues
‘Analysis Period 1 (07:00-07:15)
Ramp Number 1 2 3 4 5 6 7 8 9 10
Segment Number 2 | 4 |6 s || B ]|®]|w® g
Ramp Terminal OfR | ONR | OFR | ONR | OFR | ONR | OFR | ONR
Ramp Terminal Type siG | si6 | sic | sk | s | s | si6 | s
Number of Ramp Lanes 1 T | 0 K N ENE
Ramp Roadway Capacity (pe/h) 2000 | 2000 | 2000 | 2000 | 2000 | 2000 | 4000 | 2000
Ramp Demand, v (pc/h) 990 | 16 | 311 | 1132 | 955 | 665 | 980 | 160
‘Adjusted Ramp Demand, vRad) (pe/n) 90 | 16 | 3m1 | 1132 | 955 | ess | 980 | 180
Ramp Metering? No | No | No | No | No | Mo | No | No
Ramp Metering Rate (pe/h) B
Spilback Occurs? No | No | No | No | No | No | No | No
Ramp 1 (R) Queve (veh) 71 | 00 | 175 | 00 | 231 | 00 | oo | oo
Ramp L2 (1 Queue (veh) 00
Ramp L1 (%) Queve (1) 0 | o |as | o |se7 | o [ o | o
Ramp L2 () Queue (f) - - o

Copyright © 2024 University of Fiorida. Al Righis Reserved
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b. Selecting File > Print Preview from the main menu; this can be found by selecting the three lines in
the top left-hand corner of the screen and then selecting “Print Preview”

1 Networki-Gainesvilel - HCS Network - a8 x

= START NETWORK DETAILS RESULTS REPORT

New CtieN
Open ctie0
Save
Save As. £ Date a/9/2004
Close oW ‘Analysis Year 2024
Units Time Analyzed
e P 175 NB - Gainesvile, FL Units Uss. Customary
| print Preview CurisF2
Report
Default Setings p Type Ramp Terminal Facility Name Sonmucad Nodersgtin. | Conoaced
Help * Hramp signal SW Wiliston Road 175 NB On-/Off-Ramp S8
Exit AlteF4 poramp Signal 'S Willston Road 175 NB On-/Off-Ramp S8
3 Off-ramp, Signal SW Archer Road 175 N8 On/Off-Ramp e
s On-ramp Signal SW Archer Road 175 N8 On-/Off-Ramp s6
n Off-ramp Signal W Newberry Road 175 NB On-/Off-Ramp. N
3 On-ramp Signal W Newberry Road 175 NE On/Off-Ramp 6
-~ 16 Off-ramp Signal NW 3th Avenue 175 58 On-/oft-Ramp e
"\ « /\ 18 On-ramp. Signal NW 39th Avenue 1-75 58 On-/Off-Ramp. B
~ Spillback Analysis and Queues
Analysis Period 1 (07:00-07:15)
Ramp Number i | 2] 3 [ a]5s e 78] s 1w
Segment Number 2 | 4« |6 |8 [ n |5 [w]|w®
Ramp Terminal OFR | ONR | OFR | ONR | OFR | ONR | OFR | ONR
Ramp Terminal Type s6 | s6 | si6 | si6 | s6 | s | si6 | s6
Number of Ramp Lanes, HIE T 1 | 1 N ENE
‘Ramp Roadway Capacity (pc/h) 2000 | 2000 | 2000 | 2000 | 2000 | 2000 | 4000 | 2000
Ramp Demand, VR (pc/n) 40 | 16 | 371 | 1132 | 955 | 665 | 980 | 160
‘Adjusted Ramp Demand, vRadj (pc/h) 490 | 146 | 371 | 1132 | 9ss | ees | es0 | 160
Ramp Metering? No | No | No | No | No | No | No | Mo
Ramp Metering Rate (pe/h)
Spillback Occurs? No | No | No | No | No | No | No | No
Ramp L1 (R) Queue (veh) 71 | 00 | 175 | oo | 21 | oo | oo | o0
Ramp L2 (1) Queue (veh) ~ | oo
Ramp L1 (R Queue (10 w | o |45 | o |7 | o | o | o
Ramp L2 (1 Queue (1) o

iversity of Florida. Al Rights Reserved

c. Using keyboard shortcut “Ctrl+P” for Print
d. Using keyboard shortcut “Ctrl+F2” for Print Preview
2. Print

a. Using Print will bring up a Print dialog box where you can select which printer to print to
E:E,] Print »

General |

— Select Printer

[ CutePDF Writer
il Fax
@& Microsoft Print to PDF

<

Status: Ready

M Microsoft XPS Documen
M Oneflote
=i Samsung 5CX-4623 Serie

Preferences

Location;
E et Find Printer... i
- Page Range-

o Al

€ Selection

Mumbier of copies: I1 31

[T Collate
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3. Print Preview

a.

Using Print Preview will bring up a window where you can view how the report will look on paper
before sending it to the printer

& ®SHEDE

Date

91372024

Analys Yeor 2020
Time Anslyzed
175 N6 - Gainesvile, FL Units US Customary
Ramp Terminal Facilty Name ‘Connected Node/Segment | Connected
Type Approach
Signal 'SW Willston Road 175 NB On-/Off-Ramp. st
Signal SWWillston Road 175 N8 On/Off-Romp. E
Sgnal SW Ascher Rosd i75 [
ignal SW Archer Rood 175 E
0 Sgnal N
[0 anal V75 E
T Sgral NW 39t Avere [
s o ignal W 39th Avene 75 s
Spillback Analysis and Queues
Analysis Period 1 (07:00-07:15)
Ramp Number [ 2 3 4 S 6 7 8 9 10
Segment Number 2 | 4 |6 |8 [ n[ B |6 | e -
Romp Terminal OFR_| ONR | OFR | ONR | OFR | ONR | OFR | ONR
Ramp Terminal Type 5G| 56 | 6 | 6 | s | s6 | s6 | sie
Number of Ramp Lanes 1w ]a v w]s]z]a
Ramp Roadway Capacity (pc/h) 2000 | 2000 | 2000 | 2000 | 2000 | 2000 | 4000 | 2000
Ramp Demand A (oc/h) a0 | 146 | an1 |12 | 955 | 65 | om0 | 160
‘Adjusted Ramp Demand, vRad) (pc/h) 4% | 146 | 371 | 1132 | 955 | e6s | 90 | 160
Fomp Meterng? No | No | No | No | No | No | No | Mo
Ramp Metering Rate (pc/h) : = = =
Spilback Occurs? No | No | No | No | No | No | Mo | N
Ramp L1 (R) Queue (veh) 71 00 175 00 231 00 00 00
Ramp L2 (U Queve (veh) 00
Ramp L1 (R) Queve (1) 0 | 0 [ms | o [se | o | o | o
Romp L2 (U Queve (1) o
“Average Vehicle Spacing () 254 | 254 | 254 | 254 | 254 | 254 | 254 | 254
Romp L1 (R) Total Storage Length (1 6260 | 5260 | 6280 | 5280 | ceso | som0 | o0 | semo
Ramp L2 (1) Total Storage Length (1) - - - - o
Ramp LT (R) Queue Storage Ratio 003 | 000 | 007 | 000 | 005 | 000 | 000 | 000

b. The print icon in the toolbar found in the top left-hand corner can then be selected

C.

= e

A print dialog box will pop up where you can select which printer to print to

EHEAO

@ Print

General |

*

- Select Printer
[ CutePDF Writer = Microsoft XPS Documen:
= Fax i OneNote
& Microsoft Print to PDF o~ Samsung 5CK-4623 Sene
£ >
Status: Ready Preferences |
Loeation:
Bt Find Printer... |
— Page Range
& Al Mumber of copies: |1 5:
' Selection € Current Page
" Pages: | [T Callats ; ;
2t 22l 5

Com ]

Cancel |

Apply
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Steps for Starting Network Analysis

1.

To load a facility, create a new file. This can be done by selecting ‘New...’ on the start page, selecting ‘New’
from the main menu, or using the keyboard shortcut ‘Ctrl+N’.

A new analysis will begin, and the user has the option of loading an existing Freeways facility analysis or
creating a new one.

a. Selecting the button ‘Load Freeway Facility’ will cause an ‘Open’ dialog box to appear. Select an
existing Freeways facility (*.xuf) file to load the facility.

b. Selecting the button ‘Create Freeway Facility’ will cause the HCS Freeways module to open for the
user to create a new freeways facility analysis. Once created, the file will need to be loaded in the
Network tool.

Once a Freeways facility file is loaded, the data grid on the Network page will populate:

a. The Segment Number and Segment Type of the loaded facility file will display. Only on-ramp, off-
ramp, weaving on-ramp, and weaving off-ramp segments will display.

b. Other fields within the table will populate after external files are loaded.

Within the data grid is an ‘External File’ column. An external file (Streets or Freeways) will need to be loaded
for each segment to specify the corresponding intersection/segment connected to the ramp.

a. Clicking ‘Select’ will cause an ‘Open’ dialog box to appear. Select an existing external file:
i. HCS Streets File (*.xus)
ii. HCS Freeways File (*.xuf)

b. Once selected, the rest of the row in the data grid will populate with defaults.

c. The Connected Intersection/Segment and Approach from the selected external file can be changed
to view and include in the analysis. The corresponding columns will update based on which
Connected Intersection/Segment and Approach are selected.

d. The Ramp Terminal Facility Name and Connected Intersection/Segment Name are both pulled
from the loaded external file. However, they can be edited within the data grid.

e. The Ramp Roadway Length starts with a default value and can be edited within the data grid.

On the Network page, there is also a checkbox for ‘Assign Ramp Terminal Volumes to all Freeway Ramps’.
When this checkbox is checked, all checkboxes for ‘Assign Ramp Terminal Volume to Freeway’ for
individual ramp terminals on the Details page will be checked.

On the Details page, there are inputs for individual ramp terminals and their corresponding analysis periods.
The ramp terminal displayed can be changed by selecting the desired ramp terminal from the drop-down
menu at the top left corner of the window. Similarly, the desired analysis period can be changed by selecting
the desired analysis period from the drop-down menu at the top right corner of the window. There are four
or five sections, depending on what Ramp Terminal is displayed. They include the following:

a. Ramp Terminal Data

b. Ramp Details

c. Volume Balancing

d. Off-Ramp Lane Assignment (Note: This is only available for Off-Ramps and Weaving Off-Ramps.)
e

Freeway Inputs (Note: These inputs are pulled directly from the loaded Freeway facility file, but can
be edited within Network.)

7. When finished with editing inputs, the Results and Report pages are available to view results of the analysis.

a. Sections available on Results page
i. Ramp Terminal Data

ii. Ramp Roadway Report
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iii. Off-/On-Ramp Spillback Report
iv. Speed and Density
b. Reports available on Report page
i. Network Formatted Report
ii. Network Text Report
iii. O-D Report
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Glossary of Terms

Acceleration Lane Length

This value defines the length for on-ramp acceleration lanes. The typical length of acceleration lanes for ramps
should be obtained from the design standards used by the highway operation agency. It is measured from the
intersection of the edge of the travel way for the freeway and the ramp (the first point) and the downstream merge
point of the freeway and ramp edges of the travel way (the second point). The default value is 800 feet (or 243.8
meters in metric).

(a) Parallel Acceleration Lane (b) Tapered Acceleration Lane

The exhibit below illustrates the geometry of a typical two-lane ramp-freeway junction. It is characterized by two
separate acceleration lanes, each successively forcing merging maneuvers to the left.

1,500 ft
—_—
_V,Ei}:{::::::::::::::::::
— [ e
s -
. LAI LAZ

For two-lane ramps, the effective acceleration length must be calculated by the user based on the lengths of the
two lanes. In all equations using the length of the acceleration lane La, this value is replaced by the effective length
of both acceleration lanes Laer. The formula for calculating effective acceleration length is:

Laer = 2"Las + Laz

where
Laew =  Effective acceleration length,
Las = Length of the shorter acceleration lane, and
La» = Difference in length between the longer acceleration lane and the shorter acceleration lane

In merge and diverge areas, the capacity of the two outer lanes is reduced by 100 and 200 veh/h/In, respectively.
When the user sets the acceleration lanes to 1500 feet (or 457.2 meters in metric), only the outer lane of the merge
experiences a capacity reduction, as opposed to normally both of the outer two lanes.

Agency

This field is provided to document the agency or company associated with this analysis or project
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Analysis Period

The time frame for which the traffic demand on the freeway is being studied

Analysis Year

This field is provided to document the year for which the analysis is being performed

Analyst

This field is provided to document the name of the analyst

Approach

A set of lanes at an intersection that accommodates all left-turn, through, and right-turn movements from a given
direction (i.e., NB, EB, SB, and WB).

Assign Ramp Terminal Volume to Freeway

When this checkbox is checked, the Ramp Demand will automatically update to use the Ramp Terminal Approach
Volume instead.

Assign Ramp Terminal Volumes to All Freeway Ramps

When this checkbox is checked, all checkboxes for ‘Assign Ramp Terminal Volume to Freeway’ for individual ramp
terminals on the Details page will be checked.

Base Free Flow Speed

The methodology covers basic freeway segments with a FFS in the range of 55 to 75 mi/h (or 88.5 to 120.7 km/h
in metric). The predictive algorithm for free flow speed therefore starts with a value greater than 75 mi/h (or 120.7
km/h in metric), specifically a default base FFS of 75.4 mi/h (121.3 km/h in metric), which resulted in the most
accurate predictions in the underlying research. The adjusted free-flow speed is determined by subtracting each
speed adjustment from the base free-flow speed.

Capacity Adjustment Factor

Capacity Adjustment Factor, or CAF, is a factor used to allow the user to adjust the capacity for reduced-capacity
situations or to match field measurements. The capacity in any cell of the time-space domain can be reduced to
represent incident situations such as construction and maintenance activities, adverse weather, traffic accidents,
and vehicle breakdowns.

Connected Approach

The connected approach is the subject approach of the connected intersection in the ramp terminal

Connected Intersection

The intersection connected to the ramp of the freeway; available choices of intersections are based on the external
file selected

34 - Glossary of Terms Network User Guide



Connected Intersection / Segment ID

When the external file selected is a Streets file, available choices for the connected intersection will be based on
how many intersections are available in that file. The Connected Intersection ID would be the intersection number
in the corresponding external file.

When the external file selected is a Freeways file, available choices will be based on the ramps available in that
file. The Segment ID would be the ramp number and type in the corresponding external file. If the Segment Type in
the Network Freeway Facility loaded is an off-ramp, then the available choices for Segment ID in the Freeways
External File will be on-ramps. Likewise, if the Segment Type in the Network Freeway Facility loaded is an on-ramp,

then the available choices for Segment ID in the Freeways External File will be off-ramps.

Connected Intersection / Segment Name

When the external file selected is a Streets file, the connected intersection name will be pulled from the selected
file. This name corresponds to the ‘Intersection’ input for the selected intersection in the ‘General’ box under
‘PRIMARY INPUT DATA’

When the external file selected is a Freeways file, the segment name will be pulled from the Freeways file. This
name corresponds to the ‘Segment Name’ input for the selected segment within the facility in the Segments data
grid.

All names can be edited in the external files themselves and reloaded/refreshed in Network, or the names can be
edited in the Network data grid directly

Create Freeway Facility

A ‘Create Freeway Facility’ button is provided to open the HCS Freeways program and to allow creating of a new
Freeways facility file that can later be loaded into the Network program.

Date

This field is provided to document the date when the analysis is performed

Deceleration Lane Length

This value defines the length for off-ramp deceleration lanes. The typical length of deceleration lanes for ramps
should be obtained from the design standards used by the highway operation agency. It is measured from the
departing point between the edge of the travel way for the freeway and outer edge of the ramp (the first point) and
the downstream intersection point of the freeway and inner ramp edge of the travel way (the second point). The
default value is 400 feet (or 121.9 meters in metric).

(c) Parallel Deceleration Lane (d) Tapered Deceleration Lane

Two common types of diverge geometries are in use with two-lane off-ramps, as shown in the exhibit below. In the
first, two successive deceleration lanes are introduced. In the second, a single deceleration lane is used. The left-
hand ramp lane splits from Lane 1 of the freeway at the gore area, without a deceleration lane.
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Where a single deceleration lane is used, there is no modification to the length of the deceleration lane Lp; where
two deceleration lanes exist, the length is replaced by the effective length Lpes in all equations.

For two-lane ramps in the Freeways module, the effective deceleration length must be calculated by the user based
on the lengths of the two lanes. Where two deceleration lanes exist, the length of the deceleration lane Ly is replaced
by the effective length Lper in all equations. The formula for calculating effective deceleration length is:

Lperr=2*Lps + Lp2

where
Lper = Effective deceleration length,
Lps = Length of the shorter deceleration lane, and
Lp, = Difference in length between the longer deceleration lane and the shorter deceleration lane

In merge and diverge areas, the capacity of the two outer lanes is reduced by 100 and 200 veh/h/In, respectively.
When the user sets the deceleration lanes to 1500 feet (or 457.2 meters in metric), only the outer lane of the diverge
experiences a capacity reduction, as opposed to normally both of the outer two lanes.

Demand

The number of vehicles or other roadway users desiring to use a given system element during a specific analysis
period, typically 1 h or 15 min.

Demand flow rates must be specified for the entering freeway mainline flow and for each merge and diverge
segment. For Merge and Diverge analyses, the demand for adjacent ramps must also be specified if one exists

For weaving segments, demand flow rates must be identified by component movement: freeway to freeway, ramp
to freeway, freeway to ramp, and ramp to ramp. Where this level of detail is not available, the following procedure
may be used to estimate the component flows. It is not recommended, however, as weaving segment performance
is sensitive to the split of demand flows.

e Ramp-weave segments: Assume that the ramp-to-ramp flow is 0. The ramp-to-freeway flow is then equal
to the on-ramp flow; the freeway-to-ramp flow is then equal to the off-ramp flow.

e Major weave segments: On-ramp flow is apportioned to the two exit legs (freeway and ramp) in the same
proportion as the total flow on the exit legs (freeway and ramp).
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Demand Adjustment Factor

Demand Adjustment Factor, or DAF, is a factor used to allow the user to adjust the demand for the purpose of
calibration, or to reflect the impacts of weather, incidents, and work zones.

Driver Population

Driver population describes the level of driver familiarity in the traffic stream and is used in adjustments for speed
and capacity. The base traffic stream characteristics for basic freeway segments are representative of traffic
streams composed primarily of commuters or drivers who are familiar with the facility.

The driver population adjustment factor f, had previously been used in the HCM to reflect the effects of unfamiliar
drivers in the traffic stream and was applied as an increase in demand volume. With the addition of a unified speed
flow equation in Chapter 12 of the HCM and the ability to adjust both the base FFS and capacity in all freeway
segment chapters (12-14) to account for incidents and weather events, the driver population factor is no longer
used. Instead, FFS and capacity adjustment factors SAFpp and CAFpop are applied in combination with other
applicable SAFs and CAFs.

Analyst judgment is still required when applying recommended adjustments. However, should there be expectations
of significant presence of unfamiliar drivers, the values shown in the exhibit below can serve as a guide for the
analysis.

Level of Driver Familiarity CAFpon SAFpo0
All familiar drivers, reqular commuters 1.000 1.000
Mostly familiar drivers (0.968 0.975
Balanced mix of familiar and unfamiliar drivers (0.939 0.950
Mostly unfamiliar drivers 0.898 0.913

All or nuemhelminqlz unfamiliar drivers .852 0.863

External File

External files refer to the ramp terminal files selected for each segment. Once a freeway facility is loaded on the
Network page, the data grid on the page will update with however many segments are available based on the
freeway facility loaded. An external file can be selected for each segment. Under the ‘External File’ column of the
data grid, the ‘Select’ hyperlink can be clicked, which will cause an Open dialog box to appear. An HCS Streets
(*.xus) or Freeways (*.xuf) file can be selected. Once selected, the file name will appear in the data grid. If the file
needs to be changed, the current file name can be selected in the data grid and the Open dialog box will appear
again to allow for the new selection.

Free Flow Speed

1. The average speed of vehicles on a given segment, measured under low-volume conditions, when drivers
are free to drive at their desired speed and are not constrained by the presence of other vehicles or
downstream traffic control devices.

2. The theoretical speed when both density and flow rate are zero.
The adjusted free-flow speed is determined by the HCM equation found below.
FFS = BFFS — fiw — fric — 3.22 x TRDY-84
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where

FFS = free-flow speed of the basic freeway segment (mi/h),
BFFS = base FFS for the basic freeway segment (mi/h),
fiw = adjustment for lane width (mi/h),
fric = adjustment for right-side lateral clearance (mi/h), and
TRD = total ramp density (ramps/mi).

If a field measured free-flow speed is entered, no subsequent adjustments are made, and the adjusted free-flow
speed will simply be the field-measured free-flow speed. Freeway Merge, Diverge, and Weaving segments require
direct speed measurements, estimated from design speed or speed limit.

For metric units, Free-Flow Speed, along with all the corresponding adjustments, are measured in kilometers per
hour.

Grade Length

The length of the segment, in miles (or kilometers in metric), to represent the percent grade

Incident Type

The following exhibit shows the default CAFs associated with each incident severity:
Directional No Shoulder i Lane 2 Lanes 3 Lanes 4 Lanes
Lanes Incident Closed Closed Closed Closed Closed

2 1.00 0.81 0.70 N/A N/A N/A

3 1.00 0.83 0.74 0.51 N/A N/A

4 1.00 0.85 0.77 0.50 0.52 N/A

] 1.00 0.87 0.81 0.67 0.50 0.50

¥ 1.00 0.89 0.85 0.75 0.52 0.52

7 1.00 0.91 0.88 0.80 0.63 0.63

8 1.00 0.93 0.89 0.84 0.66 (.66

Source: Zegeer et al. [ 1).
Motes:  N/A: not applicable, the number of lanes closed equals or exceeds the number of directional lanes.
The methodolegy dees not permit all directional lanes of a facility to be closed.

The values shown in the exhibit reflect the remaining relative capacity per open lane. For example, a two-lane
closure incident on a six-lane directional facility (underscored) results in a loss of two full-lane capacities, in addition
to maintaining only 75% of the remaining four open lanes’ capacities. The result is that only three lanes worth (50%)
of the facility’s original six-lane capacity is maintained. No information is currently available on the effect of incidents
on free-flow speed, so this effect is not accounted for at this time.

Interchange Density

The average number of interchanges per mile, measured over 3 miles upstream and 3 miles downstream from the
midpoint of the weaving segment.

For metric units, it is the average number of interchanges per kilometer, measured over 4.8 kilometers upstream
and 4.8 kilometers downstream from the midpoint of the weaving segment.

Jurisdiction

This field is provided to document any jurisdiction convention or project related information
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Lane Assignment

When off-ramps have multiple lanes, queues from the downstream ramp terminal may not develop uniformly across
ramp roadway lanes. The lane assignment process allows the user to assign queues from the ramp terminal
intersection to specific ramp roadway lanes to better match field conditions.

Ramp Ramp
roadway terminal

Example 1 — Queues developing from the left-turn movement in the signalized ramp terminal

&

Ramp Ramp
roadway terminal

Example 2 — Queues developing from the right-turn movement in the unsignalized ramp terminal

Lane Width

The lateral distance between stripes for a given lane; measured in feet (or meters in metric)

Load Freeway Facility

A ‘Load Freeway Facility’ button is provided to select an existing Freeways facility file (*.xuf) to open and load into
the Network program. Once loaded, the Network table will automatically display the segment ramps (on-ramp, off-
ramp, weaving on-ramp, and weaving off-ramp) and their corresponding information.

Major Diverge

A Major Diverge checkbox will appear when the number of Ramp Lanes is 2. The checkbox will be hidden when
the number of Ramp Lanes is 1.

A major diverge area is one in which two primary roadways, each having multiple lanes, diverge from a single
freeway segment. Such junctions occur when a freeway splits to become two separate freeways or when a major
multilane high-speed ramp diverge from the freeway. Major diverges are different from one- and two-lane off-ramps
in that each of the diverging roadways is generally at or near freeway design standards and no clear ramp or
deceleration lane is involved in the diverge.
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The two common geometries for major diverge areas are illustrated in the exhibit below. In the first case, the number
of lanes leaving the diverge area is the same as the number entering it. In the second, the number of lanes leaving
the diverge area is one or more than the number entering it.

{a) Major Diverge Area with No Lane Addition (b) Major Diverge Area with Lane Addition

The principal analysis of a major diverge area involves checking the capacity of entering and departing roadways,
all of which are generally built to mainline standards. A failure results when any of the demand flow rates exceeds
the capacity of the segment.

For major diverge areas, a model exists for computing the average density across all approaching freeway lanes
within 1,500 ft of the diverge, as given in the following equation:

Dyp = 0.0175 (%)

where
Dup = density in the major diverge influence area (which includes all approaching freeway lanes
(pc/mifin)
ve = demand flow rate immediately upstream of the major diverge influence area (pc/h), and
N = number of lanes approaching the major diverge (In).

The result can be compared with the criteria of HCM Exhibit 14-3 to determine a LOS for the major diverge influence
area. Note that the density and LOS estimates are only valid for stable cases (i.e., not in cases in which LOS F
exists because of a capacity deficiency on the approaching or departing legs of the diverge).

For metric units, the calculated density in pc/mi/ln is converted to pc/km/In

Measured Free Flow Speed

The measured free-flow speed is the FFS measured in the field and provided by the user. If the FFS is measured
directly, no adjustments are applied to the measured value.

Minimum Freeway-to-Ramp Lane Changes

Minimum number of lane changes that a freeway-to-ramp weaving vehicle must make to complete the freeway-to-
ramp movement successfully. This is only applicable for one-sided weaving segments. This is denoted as LCer.

Minimum Ramp-to-Freeway Lane Changes

Minimum number of lane changes that a ramp-to-freeway weaving vehicle must make to complete the ramp-to-
freeway movement successfully. This is only applicable for one-sided weaving segments. This is denoted as LCrr.

Minimum Ramp-to-Ramp Lane Changes

Minimum number of lane changes that must be made by one ramp-to-ramp vehicle to execute the desired maneuver
successfully. This is only applicable for two-sided weaving segments. This is denoted as LCrr.
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Node

The endpoint of a link or a place along a facility where (a) conflicting traffic streams cross, merge, or diverge; (b) a
single traffic stream is regulated by a traffic control device; or (c) there is a significant change in the segment
capacity (e.g., lane drop, lane addition, narrow bridge, significant upgrade, start or end of a ramp influence area).

Number of Lanes on Freeway

This specifies the number of lanes on the freeway in the analysis direction. If there is a weaving segment, the
number of auxiliary lanes is also included. When there is a managed lane, the number of lanes is the number of
general purpose lanes. See also Lane Addition and Lane Drop.

Number of Lanes on Ramp

This specifies the number of lanes on the ramp roadway (on- or off-ramp). There can be 1 or 2 lanes.

Number of Maneuver Lanes

Number of lanes from which weaving maneuvers may be made with either one or no lane changes; denoted as
NWL.

For one-sided weaving segments, the value of Ny, is either 2 or 3. The determination is made by a review of the
geometric design and the configuration of the segment.

For two-sided weaving segments, the value of Ny, is always 0 by definition.

Origin-Destination

The Network module integrates Freeways and Streets to generate travel times between specific Origin-Destination
(O-D) pairs selected by the user. The applicable definition depends on the facility type located at the origin or
destination:

e Ifthe trip starts/ends in an urban street, an origin/destination is defined as a node (intersection) in the street
facility.

o If the trip starts/ends in a freeway, an origin/destination is defined as a segment in the freeway facility.

Peak Hour Factor

Peak Hour Factor, or PHF, is the hourly volume during the analysis hour divided by the peak 15-min flow rate within
the analysis hour. It is a measure of traffic demand fluctuation within the analysis hour.

Percent Grade

The longitudinal slope of a roadway; provided by the user as a percentage

Project Description

This field is provided for the user to document the analysis with any information for identification purposes

Proportion of CAVs

This is the proportion of CAVs in the traffic stream. CAV is a connected autonomous vehicle, defined here as a
vehicle with an operating cooperative adaptive cruise control system. The range of proportion of CAVs in the traffic
stream is from 0 to 100.
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The proportion of CAVs is used in determining a Capacity Adjustment Factor where CAVs are present in the traffic
stream (CAFcav).

Ramp Demand

This references the demand of the freeway ramp and is measured in vehicle per hour. For an on-ramp, this is the
Merge Demand. For an off-ramp, this is the Diverge Demand. For a weaving on-ramp, this includes the Ramp-to-
Freeway Demand and the Ramp-to-Ramp Demand. For a weaving off-ramp, this includes the Freeway-to-Ramp
Demand.

Ramp Metering

Roadway metering is the storing of surges in demand at various points in the transportation network. Freeway on-
ramp metering is an example of roadway metering. A checkbox is provided to indicate whether ramp metering exists
for a merge or weaving segment.

Ramp Metering Rate

When ramp metering is active, the metering rate, veh/h, is required and is stored in the existing variable RM(i,t,p).
The maximum output flow rate ONRO(i,t,p) that can enter the merge point takes into consideration the ramp
metering rate as one of its possible constraints and is properly adjusted if the ramp metering becomes the restricting
factor to the on-ramp discharge.

ONRO(i,t,p) is the maximum output flow rate that can enter the merge point from on-ramp i during time step t in the
time interval p; it is constrained by Lane 1 (shoulder lane) flow on segment j and the segment i/ capacity or by a
queue spillback filling the mainline segment from a bottleneck further downstream, whichever governs.

Ramp Roadway

For a freeway off-ramp, the ramp roadway is the road section connecting the deceleration lane and the
downstream ramp terminal. For a freeway on-ramp, the ramp roadway is the road section connecting the
upstream ramp terminal and the acceleration lane.

Ramp Roadway Length

The ramp roadway length is measured from the gore to the taper of the ramp terminal. In the case of a ramp meter,
its distance must be adjusted and should measure from the on-ramp entrance to the meter instead of the distance
to the merge point. Ramp roadway length is measured in feet (or meters in metric).

Ramp Terminal

Ramp terminals connecting to urban street facilities can be uncontrolled, stop-controlled, or signalized intersections.
Its distance is measured from the point where additional lanes are added to the intersection approaches to the stop
bar of the approach. The length of this section should be at least as long as the turn bay lengths of the approach.

Ramp Terminal Approach Volume

This references the volume of the approach specified from the ramp terminal. It is measured in vehicles per hour.

Ramp Terminal Facility Name

This field is provided to document a name for the Ramp Terminal Facility. When an external file is selected, this
information will be pulled from the selected file. However, the name itself can be edited within the Network data
grid.
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Ramp Terminal Type

Ramp Terminal Type is automatically detected based on the external file selected. There are two different types of
ramp terminals: Signal and Freeway. Abbreviations in the reports are as follows: Signal = SIG and Freeway =
FRWY.

Refresh Selected Files

A ‘Refresh Selected Files’ button is provided on the Network page to allow reloading of files so any changes to the
external file(s) will update in the data grid. Desired rows in the Network data grid must be selected before refreshing
files. The external files in the rows selected will update all information in the data grid using the latest version of the
file found in the same directory file path.

Remove Selected Files

A ‘Remove Selected Files’ button is provided on the Network page to allow removal of files that were originally
selected for the external file(s). Desired rows in the Network data grid must be selected before removing files. The
external files in the rows selected will be removed and any associated information within the data grid will disappear.

Right Side Clearance

The right-side clearance is the distance from the rightmost travel lane to fixed obstructions on a freeway; measured
in feet (or meters in metric).

Roadway Type

Roadway types include Multilane Highways or Collector-Distributor (C-D) Roadways and Freeways. For Weavings
segments, the LOS criteria changes based on the roadway type. For Merge and Diverge segments, the FFS range
is somewhat lower (45-60 mi/h) and can be estimated by using the methodology in Chapter 12 if no field
measurements are available. The capacity checks and the maximum desirable flow rates of the ramp influence
areas also change based on the roadway type.

Segment Name

This field is provided for each segment to identify the segment or specify the start point and end point of the segment
under analysis.

Segment Number

The segment number in the Network table references the segment number in the facility in the HCS Freeways
program. In the case of a Weaving segment, the segment number can repeat in the Network table since the Weaving
segment includes both an on-ramp and an off-ramp.

Segment Length
Distance in feet (or meters in metric) of each segment.
Default Segment Lengths

e Basic: 5280 ft (or 1609.3 m in metric)

o Merge: 1500 ft (or 457.2 m in metric)

e Diverge: 1500 ft (or 457.2 m in metric)

e Weaving: 3000 ft (or 914.4 m in metric)
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e  Overlap: 500 ft (or 152.4 m in metric)

The exhibit below illustrates the influence areas of Merge, Diverge, and Weaving segments without managed lanes.
A weaving segment is usually defined as the distance between the on-ramp and off-ramp gore points. However, its
influence area extends 500 ft (or 152.4 m in metric) upstream and downstream of the gore-to-gore length.

1,500 ft

——
—
—

1,500 ft

{a) Merge Ramp Influence Area (b) Diverge Ramp Influence Area

- Base Length, £, -
500 ft 500 ft

(c) Weaving Influence Area

Segment Type

There are 4 possible segment types: On-Ramp, Off-Ramp, Weaving On-Ramp, and Weaving Off-Ramp. On-Ramp
is associated with a Merge segment type in the Freeways methodology. Off-Ramp is associated with a Diverge
segment type in the Freeways methodology. Weaving On-Ramp and Weaving Off-Ramp are associated with the
entry and exit ramps of a Weaving segment type in the Freeways methodology, respectively.

Shoulder Queue Storage Length

When a shoulder is present, but its storage length is not sufficient to accommodate the unserved vehicles, this is a
special case of queue spillback. In the exhibit below, the first case occurs when there is blockage of one mainline
lane in addition to the shoulder. The second case occurs when there is blockage of two mainline lanes in addition
to the shoulder.

Segment Segment i Exhibit 38-A15

Maximum Off-Ramp Queue
Storage Length at Diverge
Segments with Occurrence of

— V\ekde ---T 1) g el (A) Regime 3a Queue
L(i) - SL{i) -LD(i) | SL{i) LD(i) O L(i) — SL(i) -LD(i) Spillback and (B) Regime 4a
—>c—> 5 —>e—>e—>

Queue Spillback, when
Shoulder is Available

>

s

& ~

L(i) - N L(i)

Side of Junction

The location of the ramp(s) relative to the freeway. There are two types: right-sided and left-sided.
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Single-Unit Trucks

Single-Unit Trucks are defined as one of two categories of heavy vehicles. Buses and RVs are treated as SUTs in
the HCM. SUTs include the following:

e Other Two-Axle, Four-Tire Single-Unit Vehicles: Two-axle, four-tire vehicles, other than passenger cars.
Generally pickup trucks, sports utility vehicles, and vans.

e Buses: All vehicles manufactured as traditional passenger-carrying buses with two axles and six tires or
three or more axles. Excludes modified buses no longer capable of mass passenger transport.

e Two-Axle, Six-Tire, Single-Unit Trucks: All vehicles on a single frame with two axles and dual rear wheels.
Includes some trucks, camping and recreational vehicles, and motor homes.

e Three-Axle Single-Unit Trucks: All vehicles on a single frame with three axles. Includes some trucks,
camping and recreational vehicles, and motor homes.

e Four or More Axle Single-Unit Trucks. All trucks on a single frame with four or more axles.

Speed Adjustment Factor

Speed Adjustment Factor, or SAF, is a factor used to allow the user to adjust speed based on a combination of
different sources, including weather and work zone effects. The SAF may also be used to calibrate the estimated
FFS for local conditions or other effects that contribute to a reduction in FFS. For example, poor pavement
conditions or sun glare may result in drivers reducing their speeds even under low-volume conditions.

Terrain Type

An extended length of highway containing a number of upgrades or downgrades where no single grade is long
enough or steep enough to have a significant impact on the operation of the overall segment. There are three types
of terrain: Level, Rolling, and Specific Grade.

See also Level Terrain, Rolling Terrain, and Specific Grade.

Time Analyzed

This field is provided to document the time frame of the analysis as morning peak, afternoon peak, existing
conditions, future projections, etc.

Total Ramp Density

The average number of on-ramp, off-ramp, major merge, and major diverge junctions per mile (or kilometer in
metric). It applies to a 6-mi (or 9.7-km in metric) segment of freeway facility, 3 mi (or 4.8 km in metric) upstream
and 3 mi (or 4.8 km in metric) downstream of the midpoint of the study segment.

For segment analyses, ramp density is computed for a 6-mi (or 9.7-km in metric) section centered on the segment’s
midpoint; however, for facility analyses, ramp density is calculated across the entire facility (i.e., total number of
ramps divided by total facility length).

Total Trucks

The percentage of trucks in the traffic stream. Trucks are heavy vehicles engaged primarily in the transport of goods
and materials or in the delivery of services other than public transportation. All heavy vehicles are classified as
single-unit trucks (SUTSs) or tractor-trailers (TTs).
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Tractor-Trailers

Tractor-Trailers are defined as one of two categories of heavy vehicles. TTs include the following:

Four or Fewer Axle Single-Trailer Trucks: All vehicles with four or fewer axles consisting of two units, one
of which is a tractor or straight truck power unit.

Five-Axle Single-Trailer Trucks: All five-axle vehicles consisting of two units, one of which is a tractor or
straight truck power unit.

Six or More Axle Single-Trailer Trucks: All vehicles with six or more axles consisting of two units, one of
which is a tractor or straight truck power unit.

Five or Fewer Axle Multi-Trailer Trucks: All vehicles with five or fewer axles consisting of three or more
units, one of which is a tractor or straight truck power unit.

Six-Axle Multi-Trailer Trucks: All six-axle vehicles consisting of three or more units, one of which is a tractor
or straight truck power unit.

Seven or More Axle Multi-Trailer Trucks: All vehicles with seven or more axles consisting of three or more
units, one of which is a tractor or straight truck power unit. Includes triple-trailer combinations.

Weather Type

There are different types of weather conditions. The HCM categorizes weather into 11 different types. These
include: Medium rain, Heavy rain, Light snow, Light-medium snow, Medium-heavy snow, Severe cold, Low visibility,
Very low visibility, Minimal visibility, and Non-severe weather.

The tables below provide default CAFs and SAFs by weather type and facility free-flow speed. Note that the changes
in CAFs and SAFs for decreasing visibility shown in the exhibit may be counterintuitive, since they are based on a
single site.

The SAF is applied to the base free-flow speed, and CAF is applied to the base capacity, both of which are
calculated in the respective methodological chapters for the various freeway segment types. Both may also have
been adjusted in the process of calibrating the core facility in Chapter 10 of the HCM. The adjustment factors below
should be applied in addition to any prior CAF and SAF calibration.

Default CAFs by Weather Type:

Capacity Adjustment Factors

55 60 65 70 75
Weather Type Weather Event Definition mifh mi/h mi/h mi/h mi/h
Medium rain > 0.10-0.25 in/h 0.94 093 092 091 090
Heavy rain > 0.25 in/h 0.80 088 086 084 0.82
Light snow >0.00 = 0.05 in/h 097 096 096 0.95 095
Light—medium snow >(.05 — 0.10 in/h 095 094 092 090 0.88
Medium—heavy snow >0.10 — 0.50 in/h 093 091 090 0.88 0.87
Heavy snow >(.50 in/h 080 078 076 0.74 0.72
Severe cold <-4°F 093 092 092 091 090
Low visibility 0.50 — 0.99 mi 0.90 090 090 090 090
Very low visibility 0.25 — 0.49 mi 088 088 088 0.8 0.88
Minimal visibility < 0.25 mi 0.90 0.90 0.90 090 0.90
Non—severe weather All conditions not listed above 1.00 1.00 1.00 100 1.00

Source: Zegeer et al. (1).
Note:

Speeds given in column heads are free-flow speeds.
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Default SAFs by Weather Type:

Speed Adjustment Factors

55 60 65 70 75
Weather Type Weather Event Definition mi/h mi/h mi/h mi/h mi/h
Medium rain > 0.10-0.25 infh 096 095 094 093 093
Heavy rain > 0.25 in/h 0.94 093 0.93 092 0.91
Light snow >0.00 — 0.05 infh 0.94 0.92 0.89 0.87 10.84
Light—medium snow >0.05 — 0.10 in/h 092 090 088 086 083
Medium—heavy snow >0.10 — 0.50 in/h 090 0.88 0.8 084 0.82
Heavy snow >0.50 in/h 0.88 086 0.85 0.83 0.81
Severe cold <-40F 095 095 094 093 092
Low visibility 0.50 — 00,99 mi 0.96 095 094 094 0.93
Very low visibility 0.25 — 0.49 mi 095 094 0.93 092 091
Minimal visibility < .25 mi 095 094 093 092 091
Non—severe weather All conditions not listed above 1.00 100 1.00 1.00 1.00

Source: Zegeer et al. (1.

Mote:

Speeds given in column heads are free-flow speeds.

Weaving Configuration

Configuration of a weaving segment refers to the way that entry and exit lanes are linked. The configuration
determines how many lane changes a weaving driver must make to complete the weaving maneuver successfully.
There are two types of weaving configurations: one-sided and two-sided.

e A one-sided weaving segment is one in which no weaving maneuvers require more than two lane changes
to be completed successfully. The following illustrates two examples of one-sided weaving segments:

(a) One-Sided Ramp Weave

(b) One-Sided Major Weave

o A two-sided weaving segment is one in which at least one weaving maneuver requires three or more lane
changes to be completed successfully or in which a single-lane on-ramp is closely followed by a single-lane
off-ramp on the opposite side of the freeway. The following illustrates two examples of two-sided weaving

segments:

(a) Two-Sided Weaving Section
with Single-Lane Ramps

(b) Two-Sided Weaving Section
with Three Lane Changes
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Weaving Length

The distance between the merge and diverge that form the weaving segment. There are two measures of weaving
segment length: short length and base length.

e Ls = short length, the distance in feet (or meters in metric) between the end points of any barrier markings
(solid white lines) that prohibit or discourage lane changing

e Ls = base length, the distance in feet (or meters in metric) between points in the respective gore areas
where the left edge of the ramp-traveled way and the right edge of the freeway-traveled way meet

The following illustrates the two measures of weaving segment:
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